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This manual was written for use with the Rubicon™ Archive software version 2.0. This manual
and the Rubicon software described in it are copyrighted, with all rights reserved. This manual
and the Rubicon software may not be copied, except as otherwise provided in your software
license or as expressly permitted in writing by Indigo BioSystems, Incorporated.

All other trademarks and service marks are the property of their respective owners.
Copyright © 2007 by Indigo BioSystems, Incorporated. All rights reserved.

UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, SHALL INDIGO BIOSYSTEMS,
ITS LICENSORS OR THEIR DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE
FOR ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES
FOR LOSS OF BUSINESS, LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF
BUSINESS INFORMATION AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO
USE THE SOFTWARE OR ITS DOCUMENTATION, EVEN IF INDIGO OR AN INDIGO
AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OR EXCLUSION OF
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION
OR EXCLUSION MAY NOT APPLY.

Contact

Indigo BioSystems, Inc.

111 Congressional Blvd. Suite 160
Carmel, Indiana 46032

Tel.: (317) 536-2736

Fax: (317) 536-9204

Sales: sales@indigobio.com

Technical Support: support@indigobio.com
All other inquiries: info@indigobio.com
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Chapter 1: Introduction

11

1.2

1.3

1.4

1.5

1.6

System Description

Rubicon is a system for the collection, storage, and retrieval of raw, processed, and
summarized analytical data. It is a multi-tier application that includes a client, application
server, and database. Rubicon is a “write-once, read-many” type system. Its purpose is to
manage raw data, allowing data to be written and retrieved, but not modified or deleted
by end-users or system managers of Rubicon.

Purpose

This document describes tasks related to the daily use of the Rubicon Archive client and
server.

Revisions to this Guide

All information is new in this Tutorial Version 1.0. This section will update as new
manuals are developed for software revisions.

Technical Support

For any issues with your software or this manual, please contact Indigo BioSystems
Technical Support at:

Tel.: (317) 536-2736
Email: support@indigobio.com

System Requirements
To install and use Rubicon, you must have the following:
Operating System: Windows XP Professional SP2
Min. RAM: 512MB
Min. Screen Resolution: 1024x768
Software: .Net Framework 2.0 (May be distributed with the installation media)

Acronyms and Abbreviations
The following acronyms and abbreviations are used throughout this manual:

Term/Acronym Definition

Group A construct that links users to labels and controls user access to
data

1Q Installation Qualification
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Term/Acronym Definition

Java Java software from Sun Microsystems, Inc.

J2EE Java 2 Enterprise Edition

Label A collection of properties that defines the meta data associated with
a package

RAM Random Access Memory

Rubicon The set of hardware and software described in this complete
Validation Package.

WAR Web Archive

1.7 Conventions Used in this Manual
Menu choices are in bold text.

Y

<]
Best practice suggestions are denoted witha % graphic.

I\ Y

Hints and Tips are also denoted witha % graphic.
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Chapter 2: Rubicon Archive Repository and Web
Application

2.1  Starting the Rubicon Repository Web application

To log into the Rubicon repository:

1. Log in to the Rubicon repository using the URL, username and password
provided by the Administrator.

= Rubicon: Login - Windows Internet Explorer

@‘ )+ |3 hitps:frepository. prot-db. orgirubiconflogin htm ][] [] [0 o]
File Edt view Favorites Tools Help
Google |G+

ol | Send tow () settingsw

W g EHRubion: Loan T

&% rubicon

indigo biosystems

= »
£ v B e ov hPage - (G Tooks +

Username | |

Password

Copyright @ 2007 Indiga BioSystems, Inc. Al rights reserved
Version 21153 1124

@ mtermet F00% v

2. Type in a new password and retype to confirm. Password requirements are listed
below the Confirm Password box. Click Save to accept the new password.
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" Rubicon: Change Password - Microsoft Internel Explorer jell=ifed
File Edt View Favorites Toos  Help w
Qﬁack - Q |ﬂ @ _;‘J /_" Search i}\?Favw\tEs o [_--'j- ; i® _\ i é‘j 3

Address | @] http:jflocalhost:5080/rubiconjchangePassward. htmrexpired=t I":} Gn Links [] Rubicon Login - local 4] Google s Rubicon Loain - Sun ] émail &) Rubican Login - appsers
A - ¥ - 2 [ lv_H searchwieh - &7 B | Emal - @My vahoo! - Y shopping = EF Answers + @ Personals - [sionn -
|_:. Rubicon: Changs Password | & add Tab| (%]

% rubicon —_—

indigo biosystems. | Search Archive

my rubicon the archive groups: labels ackvan

Change Password

Wour passwaord has expired. Please update your passward.
tabtech_01

Details

Current Password

Hew Password

Confirm Hew Password '....‘

Passwords may contain letters, numbsts, undstscores( ), and tashes(-) and mist have & lsngth between 3 and 128

Save ; Cancel

Copyright @ 2007 Indign BioSystems, Inc. Al rights reserved.
Version21.1.55/1.2.4

&) Done

% Local intranet

3. The user's My Rubicon page displays.

2.2  The My Rubicon Screen
The user’'s My Rubicon screen displays the following:

Account Details lets the user know when his password will expire and links
to the Change Password screen.

The Stats section displays the count and size of each archive.
The Groups & Labels section lists this user’s associated group and labels.

An Advanced Search box displays on this screen for a quick, simple search
of the user’s archives.

02008 Indigo BioSystems, Inc. Page 7 of 7



Rubicon Archive 2.0
User Guide 1.0

File Edit Wiew Favorites Tools  Help

eﬁack i ) m @ :h /':"Search '{\?Favuntes 5

- B - LJE S B

Aclivess | @] https flocalhost 8080 rubiconuser fmyRubican.him

- ¥l - 2|

|| Rubicon: My Rubicon | | o+ add Taﬁi

v
[w| searchweb ~ 22 B | Emal ~

Go ks [&] Rubicon Login - locsl @] Google o Rubicon Login - Sun &5 Gmail & Rubicon Login - appsers
@My vahoo! - (% shopping + EJ Answers ~ @ Personals ~ [k sionIn -

ar

#¥ rubicon

My Rubicon

LABTECH_01

Account Details

‘Wvelcome LABTECH_01  Legout

Vour password has been successfully changed.

acvanced search

JI Search Archive

Password Expiration Date 08/10:2007

Change Pagswaord

Stats
Count Size(MB} Ave Size(MB)
LABTECH_01 o
£ Bioanalytical 0
The Archive a o T
More Stats

Groups & Labels

Group Labels Users
% Bisanalytical () kioanalvtical label 1

&) Done

Copyright © 2007 Indigo BioSystems, Inc. Al rights reserved.
‘ersion 21155 /124

% Local intranet
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Chapter 3: Common Repository Functions

3.1. Viewing Group Details

To view the details of the user’s group, click on groups on the My Rubicon screen menu
bar. The group name and retention policy, and associated labels and users are
displayed.

r 2 Rubicon: Group Details - Microsoft Internet Explorer enfi=ifr
Fle Edit W¥ew Favortes Tools  Help w
Qﬁack - Q |ﬂ @ _;‘J /_" Search i}\?Favw\tEs o [_."j- ; ] - _\ i é‘j 3

Address | @] http:jflocalhost:8080/rubiconjusergroup. htm7id=1 I":} B Links [] Rubicon Login - local 4] Google s Rubicon Loain - Sun ] émail &) Rubican Login - appsers
A - ¥t - vl lv_H searchwieh - &7 B | Emal - @My vahoo! - Y shopping = EF Answers + @ Personals - [sionn -
|_:. Rubicon: Group Details | & add Tab| B8

Welcome LABTECH_01  Logout

% rubicon —_—

indigo biosystems. | Search Archive

my rubicon the archive groups labels ackvan

Group Details
Groups = Detalls

Bicanalytical

Details

Retention policy 0035-00-00 (years-months-days)

Labels

= bloanahtical labsl

Users

Username Is Active s Admin
LABTECH_01 o

Copyright 2007 Indigo BioSystems, Inc. Al rights reserver.
Version 21155 /124

&) Done % Local intranet

3.2. Viewing Label Details

To view the details of a label, click on labels on the My Rubicon screen menu bar. The
group name and label status and properties are displayed.
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iils - Microsoft Internet Explorer

Fle Edt Wew Favores Tools  Help 7
; A | @ e T i
¢ 2 \ ) o e & 1 RX
OO RNBG P o= @ 3% - %S
Address ] http: flocalhost:3080frubican/user label, htm?id=18qid= [s] B Links [] Rubicon Login - local @] Google o Rubicon Login - Sun ] Gmall & Rubicon Login - appsery
LA - ¥ - o [w}} searchweb + | 7 ER~ | =Ml > @myvahoo! = (P shopping - EJ Answers + @Personals ~ [ SignIn -
[T rubcon; Labelpetals || 4 pddTah| (%]

Welcome LABTECH_01  Logout

% rubicon —_—

indigo biosystems. | Search Archive

my rubicon the archive groups: labels

Label Details
Labels = Detals

(& bicanalytical label

Details

Group 5 Binanalyticsl

Status

Required  ‘as
Superseded Mo

Properties

bioanalytical prop - str (STRING) Ta
b

bioanalytical prop - num (NUMBER) oz 100

ftical prop - date (DATE)

Bicanalytical prop - bool (BOOLEAN} [fre |ﬁ'

Copyright © 2007 Indign BioSystems, Inc. Al rights reserver.
ersion21.1.55/1.2.4

&) Done % Local intranet

3.3. Viewing Archives
To view the details of an Archive:
1. Click on the archive tab from the menu bar.

2. By default, all values for the property are selected and displayed in the
contents pane at the bottom of the screen.

3. The selected label drives what information is displayed. Multiple selections
can be made to display more than one Label and more than one property
within a Label. Selecting specific values in each property can narrow the
scope of what is reported.

IMPORTANT NOTE:

A% | Auser can see only those archives he has created in the Browse
o Archive screen. An Admin can see all archives for all users in the
Browse Archive screen.

02008 Indigo BioSystems, Inc. Page 10 of 10



Rubicon Archive 2.0
User Guide 1.0

The Browse Archive screen archive listing:

Path displays the folder and filename of the uploaded files in the archives.
Expand or collapse arrows at the top control the display.

Uploaded displays the date and time the file was uploaded to the repository.

Archive displays the archive number associated with that upload. Non-admin
users cannot make changes to archives.

User displays the username associated with that archive.
Properties display the property values in the file.
Results per Page controls how many files can appear on one page.

3.4. Running the Archive Report

From the Browse Archive screen, a printable archive report can be created:

1.
2.

Click on the Create Report button.

The Archive Report displays as shown and can be sent to the printer by
clicking on the Print button. Archive details selected from the Browse Archive
screen determine the scope of the Archive Report.
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3.5. Downloading Archives
To download the details of an Archive to a local PC:

1. Select the folders or files to download by placing a checkmark in the checkbox
to the left of the name in the archive detail listing on the Browse Archive
screen.

2. Click the Download button above the detail listing to display the confirmation
page as shown below.

3. Click the Download button again to begin the download process.
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4. The download creates a zipped file called archive.zip by default. Click on the

Save button at the File Download screen to save or rename and then save the
file.

IMPORTANT NOTE:

By default, Mozilla Firefox downloads the archive.zip file to the
Desktop. If the file already exists, Mozilla renames the file
archive(2).zip. The file can then be renamed from the Desktop.
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3.6. Performing Searches
To search archives in the repository:
1. Click on the advanced search tab from the menu bar.
2. Enter search criteria and click on the Search button.
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The Advanced Search screen allows for the following types of searches:

Any, all allows the user to search for keywords, filenames, Archive ID. Wildcard
characters may be used in search terms.

Label allows the user to search for property values in a particular label.

Date allows the user to search in archives uploaded in a specified date range.
Note that future dates are not searchable at this time. An “invalid date” error will
result if future dates are chosen.

IMPORTANT NOTE:

The results window includes a clickable Archive ID that will return the
user to the Browse Archive window for that archive.
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Chapter 4: The Rubicon Client Interface

4.1. Starting the Rubicon Client Interface
To log into the Rubicon client:

1. Double-click on the Rubicon Archive (Interactive) icon to start the Rubicon
client interface.

2. Enter the User ID and Password provided by the Administrator and click the
Log In button. Note: the repository location in the title bar is set up by the
Administrator.

4.2. The Rubicon Overview Screen
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%

Menu Bar
Title Bar

/ File
Directory Listing
Tree

Staging

Area

The File Menu:

New Package reset the package list by clearing any files listed in the staging
area and clears any groups that have been selected.

Apply Label opens the Package Label Information dialog box.
Send Package uploads selected files.

Printer Selection sets up and selects the printer.

Preferences are detailed in Section 5 of this Guide.

Exit closes the application.

The Help Menu:
The Help Menu displays the About Indigo window.

The Title Bar:
The Globe icon opens the repository.
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The Up Arrow Folder icon navigates to the parent folder of the one currently
selected.

The Paper and Pen icon opens the Package Label Information screen.
The Arrows drill down and up in the directory tree.
The File View icon is a drop-down list of available file window views.
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Chapter 5: Common Rubicon Client Functions

5.1. Working with Files

This section describes how files are collected and archived in the repository.

5.1.1. Adding Files
To add files to the staging area:

1.

Locate the directory in the Directory Tree. The folder contents will
display in the top right File Listing pane.

Select the folder or the individual file(s) (multiple files can be selected
using Windows ctrl+click or shift+click combinations) to be uploaded to
the archive.

Click on the Add down arrow on the rubicon menu bar to add the files
to the staging area. Rubicon checks for duplicates in the database (an
option in Preferences) and calculates and displays the Checksum
value as files are added. The date and time the file was added, the file
type and full path are also displayed in the staging area.

If a file has been added in error, simply click on the Remove up arrow
to remove the file from the staging area.

IMPORTANT NOTE:

This is the last opportunity to remove files from an archive. Files,
groups, and labels cannot be removed once uploaded to the
repository.

5. To upload the files in the staging area, click on the Send right arrow.

Continue to the next section for details on uploading files.
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5.1.2. Uploading Files

To upload the files to the repository:

1. After adding files to the staging area and clicking on the Send button,
complete the Package Label Information as shown below. Choose
the group from the drop-down list. Choose properties and converters
for this package. Add valid values if necessary by clicking on the Add
Value button. Note that any values provided here apply to all files in
the staging area upload list.

2. Click on the OK button to accept details.
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3. Electronically sign the package by providing the password assigned by
the administrator.

4. Uploaded files are removed from the staging area and added to the
statistics on the My Rubicon repository screen.

IMPORTANT NOTE:

To upload files, users must be associated with a Group. If a user has not been associated with a
Group and tries to log on, the following error message displays:

The user must contact the Administrator to correct the problem and be able to upload files.
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5.2. The AutoArchiver
This section describes how users can schedule package uploads in the AutoArchiver.

5.2.1. Adding Files to the AutoArchiver
To set up a folder to automatically archive:

1. Double click on the Rubicon AutoArchive (Service) icon to open the
AutoArchiver and place the Service icon in the Windows taskbar
(bottom right corner of screen).

2. Right click on the icon in the taskbar and choose Setup to open the
Rubicon AutoArchive Setup application.

3. Inthe directory tree, click to select the folder that should be
automatically archived. Click the Add button to add the folder to the
staging area.

4. The Package Label Information dialog box opens for the user to select
the group and property values and set the desired schedule.

5. The package must be electronically signed.
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6. The message box confirms the successful creation of the Auto
Package.

7. The scheduled package appears in the staging area.
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8. To view the schedule activity, right click on the AutoArchive icon and
choose Status from the menu. The following screen displays.

9. Torun areport on uploaded files, select the scheduled package and
click on the Report button. Define required timeframe as shown below.
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10. To exit the AutoArchive Setup, right click the icon in the taskbar and
choose Exit from the menu.

5.2.2. Removing Files from the Auto Archiver

To stop a folder’s automatic archive, click the package definition in the staging
area.

5.3. Setting Preferences
The user can set the below preferences in the Rubicon Client interface:
The Endpoint is setup during the installation of the repository.
The inactivity timeout can be increased or decreased.

The level of compression can be defined by selecting a value between 0 (no
compression, fast but large files) and 10 (max compression, slow but small files).
The default value is 5.

When a file is archived, the original file is renamed with the extension .RARC
added to the file name to indicate that the file has been archived.

Successfully archived files  can be deleted from the file system once uploaded
to the repository.

By default, the Warn if file already exists in archive before uploa  ding option
is selected.

The XML Converter can be visible or hidden.

System and hidden files allows the user to upload any hidden or system files
into the archive.
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